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AmigaOSs 3.2 for all Classic Amigas released and available

AmigaOS 3.2 for all Classic Amigas rel d and availabl

Brussels, May 14, 2021
Hyperion Entertainment CVBA is very pleased to announce the immediate availability of AmigaOS 3.2 for 68K based Amigas.

AmigaOS 3.2 comes packed with well over 100 new features, dozens of updates that cover nearly all AmigaOS components and a battery of bugfixes
that will undoubtedly solidify the user experience.

AmigaOsS 3.2 is the result of more than 2 years of intense and relentless work from a team of over sixty people who have contributed to produce a
new milestone in AmigaOS history.

Hyperion Entertainment CVBA has no words to express its gratitude to this talented and resilient team for its impressive work ethic.

The most comprehensive version of AmigaOS 3.2 is available now on CD-ROM and contains all the disks and AmigaOS Kickstart ROM sets for all
Amiga machines ever produced allowing users to install AmigaOS 3.2 on multiple different types of Amigas at once.

Place your order now with your Amiga dealer of choice!

Digital (machine type specific) downloadable versions will follow.

AmigaOSs 3.2 FEATURE LIST SUMMARY

1. ReAction GUI toolkit integration

2. Built-in ADF (Amiga disk file image) management
3. Integrated Help subsystem

4. Updated Data Type system

5. Workbench and other user interface improvements
6. Improved Tools, Utilities and System applications
7. Enhanced Shell behavior

8. New and reworked command set

9. Touched up Preferences

10. Polished MultiView

11. Revamped Commodities

12. Expanded BootMenu

13. Inclusion and refinement of the AmigaOS 3.1.4 feature set
14. Flexible delivery media

15. Many remarkable additions

1. REACTION GUI TOOLKIT INTEGRATION

* The incorporation of the ReAction GUI Toolkit not only opens up a plethora of existing applications for AmigaOS 3.2 users, it also ensures much
easier portability and cross-development between different versions of AmigaOS

= No additional installation required, it just works, even on low-end 68000 systems

» A new multi-file text editor called "TextEdit" is included as a show-case

= ReAction has its own Preferences editor which lets you set backfilled patterns for ReAction based programs

» Fresh and bug fixed Classes backport from AmigaOS 4.x with many exclusive characteristics and brushed up aesthetics
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Workbench Screen

Window

2.BUILT-IN ADF (AMIGA DISK FILE IMAGE) MANAGEMENT

» DAControl & trackfile.device provide unprecedented functionality, as they enable users to create, mount, insert and eject ADF files

ADF images are handled just like any physical floppy disk

On "Workbench" you can mount an ADF image by double-clicking on it

ADF handling can be accomplished via Shell through the use of an extensive set of available options
Accessing such mounted ADF disk image files is fast and requires very little memory

Multiple ADF disk images can be mounted at the same time

A shared cache system is available in order to speed up ADF operations

3.INTEGRATED HELP SUBSYSTEM

A complete "Reference Manual" covers all commands and most complex topics

An AmigaGuide based central "Help hub" is available by simply pressing the HELP key
The Help database can be quickly queried from the Shell/CLI

Preferences and many other programs contain Help menu items

In the WBStartup folder, MenuTools adds the "Help" menu item to the "Tools" menu but can be customized to add other Tools as well

4.UPDATED DATA TYPE SYSTEM

New AIFF uncompressed audio data type

New GIF image data type

New WAV audio data type

New JPEG picture data type

New PNG multi-platform image data type

New BMP data type for Windows/OS2 bitmap images

New Icon.datatype enables use of ".info" files as images

New ACBM picture data type (used in AmigaBASIC & SpectraPaint)
The AmigaGuide data type can now display inline images

Text data type with search functionality

Faster and more configurable CDXL and ANIM data types
Sound.datatype manages bit rate samples of 8, 16, 24 and 32 bit
Picture.datatype is now stunningly fast even on low-end 68000 processors

5. AMIGAOS WORKBENCH AND OTHER USER INTERFACE IMPROVEMENTS

Resize windows from any border

Window iconification

Workbench title bar customization

Maximize a window by holding down the SHIFT key and clicking on the window zoom gadget
The [ESC] key quits easy requesters

Scalable "GadTools" user interface adapting to different font sizes

Workbench menu "Open volume"

https://hyperion-entertainment.com/index.php/news/1-latest-news/290-amigaos-42-for-all-classic-amigas-released-and-available

2/5



5/14/2021 AmigaOS 3.2 for all Classic Amigas released and available

# Menu Window -> Sort Order (Forward or Reverse)

# Off-Screen windows is a built-in default that is now configurable

» Scrollers and sliders now feature 3D-style embossed knobs and a darker container background
» Newer Look menus: Palette Prefs "Menu Bright Edges" + "Menu Dark Edges"

s Newer Look menus: sub-menu indicator changed from "»" to a black filled triangle

# Newer Look menus: checkmark glyph replaced by a black filled circle in mutually-exclusive options

* Workbench Prefs defines drawer placing in text mode

Zmiga Workbench Release 3.2 2.015.616 Chip-RAM 395.810.080 sonstiges RaM CPU 68040 11 akt

-

Ram Disk

6.IMPROVED TOOLS, UTILITIES AND SYSTEM APPLICATIONS

# Interactive partition "Mounter"
* "Find" allows you to quickly search for file names or file content
* "ShowConfig" now has aesthetically pleasing user interface and displays AutoConfig hardware in a human readable form

# HDToolBox can now operate from read-only media if needed

7.ENHANCED SHELL BEHAVIOR

Configurable TAB autocompletion

Ability to drop icons into Shell windows

Shell error redirection

"Execute” is now an internal Shell command

"History" is a new internal Shell command

Shell operators && and || for AND plus concatenation operations

A debug variable sends executed commands to the serial port

Shell-startup has been adjusted for easier customization
8.NEW AND REWORKED COMMANDS

# C:Eval properly groups operations

» C:Copy gains a FORCE option to overwrite targets

» C:Protect gains USER, GROUP, OTHER, CLONE, CLEAR, FILES, and DIRS
# C:SetDate can copy the date FROM a file

* C:List provides FLAT, SORT, USERS, GROUP, LFORMATQUOTE options

* C:Mount SHUTDOWN attempts to shutdown handlers

* C:Assign incorporated DENIED and DISMOUNT switches

# C:Type supports AUTO, TEXTONLY, WIDTH and BUFFER options
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# C:Reboot restarts your Amiga but waits for any ongoing write operations to prevent validation issues
# C:Group and C:Owner commands added for networked environments

* C:MD5Sum calculates and compares checksums of files and volumes

# C:MountInfo command helps in the creation of MountLists

# C:Break and C:ChangeTaskPri NAME handle wildcards options

# C:Deflcons identifies files and applies a default icon to them

» C:AssignWedge allows users to create or deny an assign on the fly

* C:LoadMonDrvs simplifies and quickly starts monitor drivers.

9.TOUCHED UP PREFERENCE EDITORS

= Custom printer output device and unit number

= WBPattern has layout options for Backdrops, Screens and Windows which include both color and dithering

# PointerPrefs has been overhauled to support 40 different pointer types

# Font Preferences comes with Shadow and Outline font options

= |Control received a massive makeover which introduced new functionality such as Window and screen border aspect ratios customization

10.POLISHED MULTIVIEW

* A new "Edit/Paste" menu item opens the contents of clipboard unit 0 (thus complementing "Edit/Copy")

* The "About" window now reports the width, height and depth of the currently displayed picture or animation

* The names of ARexx scripts for user menus can now be up to 40 characters long and may contain "spaces"

# Pressing the [Shift] key while the "Save as..." menu item is selected, forces MultiView to save the displayed document in IFF format

# Now lists pattern matching in its ASL requester that, if removed, can also display icons (useful in conjunction with the new icon.datatype)

11.REVAMPED COMMODITIES

"RAWBInfo" is an improved replacement of the icon information tool

"AsyncWB" is an AmigaOS Workbench enhancement Commodity with divers functionality

"AutoPoint" KEEPSTRINGS prevents this Commodity from automatically stealing focus from a window with an active string gadget
"ClickToFront" TOBACK_QUALIFIER selects a qualifier for sending windows back (with a single click)

"ClickToFront" no longer brings Workbench windows to the front when double-clicking on an icon

"NumericPad" allows numeric pad keys to be remapped to the standard keyboard

The "AutoArrangelcons" Commaodity-like set of scripts automates the ordering and snapshot of icons in the active window

12.EXPANDED BOOTMENU

# An option to trace the Startup-sequence line by line is now available

* The user can disable ROM Module updates by clicking on a gadget

* The hardware expansion screen displays expansion board addresses and sizes

# A new option to redirect serial port output to a file is available with the "Enable System Log" option

* The "Failsafe" boot gadget starts the Amiga in a robust and safe environment to carry out maintenance and troubleshooting tasks
* More keyboard shortcuts for the majority of options

» Displays AmigaOS Kickstart version numbers

13.INCLUSION AND REFINEMENT OF THE AMIGAOS 3.1.4 FEATURE SET

Support for storage media bigger than 4 GB
Modernized AmigaOS Workbench

DiskDoctor for disk diagnostic and salvage operations

Native support for pipes, softlinks, hardlinks and long filenames

CrossDOS supporting FAT 32 and long filenames

CD-ROM file system that supports Rockridge and Joliet extensions as well as UDF and now also Macintosh HFS

Both FFS (FastFileSystem) and the CD-ROM file system are now smarter, faster, and multi-threaded

Fully reworked and bug-fixed printer drivers

Built-in Glowlcons support as an installable option
More than 2100 icons in Glowlcon style included on the AmigaOS 3.2 CD-ROM

14.FLEXIBLE DELIVERY MEDIA

The distribution AmigaOS 3.2 CD-ROM contains ADF disk images that can be transferred to physical floppy disks or Gotek-type drives

All Modules disks perform as emergency boot disks too

The DiskDoctor disk can help users to quickly get back on their feet when facing disk failures

The AmigaOS 3.2 CD-ROM content can be copied "as is" to an Amiga formatted hard drive and booted right away for installation thanks to the
"Amiga Preinstallation Environment" (AmigaPE)

All Amiga model disks and AmigaOS Kickstart ROM set images are available on the AmigaOS 3.2 CD-ROM

Attractive printable labels are available for all your favorite AmigaOS 3.2 storage media variants (AmigaOS 3.2 CD-ROM version only)
Experimental CD-ROM-based Amiga CDTV and Amiga CD32 support

15.MANY REMARKABLE ADDITIONS

# \Wheel mouse support for scrolling on AmigaOS Workbench windows

» |Prefs stacks multiple changes and refreshes the screen only once
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|IPrefs points out names of blocking windows when refreshing

No more DF0:???? icons as disk.resource now does proper checking

Increased ROM Modules flexibility by loading more modules from disk without requiring an additional reboot for them

"HappyENV/ENV-Handler" functionality reimplementation incorporated

No more MaxTransfer values required for built-in Commodore and other well-known hardware controllers from various manufacturers

"Installer" is more compatible with previous AmigaOS versions

Multiple input events are supported by input.device

Two new alerts report module issues for easier system diagnosis

New API features for developers

Optional generic processor support libraries for 68K CPU boards
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